
 
Dreamweaver MX - Introduction 

 
Dreamweaver is an HTML (Hypertext Markup Language) editor, authoring tool, and Web site 
management tool.   Dreamweaver is a WYSIWYG (what you see is what you get) web page 
editor that is very powerful and easy to use.  
 
If you don’t have Dreamweaver yet, visit the site below and download the demo version for an 
evaluation prior to purchasing the software.    
 
http://www.macromedia.com/software/dreamweaver/  
 
The Work Area 
When you open Dreamweaver you will see the Document Window with Panels and Panel groups 
that change settings depending on what you are creating or editing.  The new look of MX saves 
screen space and makes learning the interface a lot easier.   The Document Window displays 
your web page approximately as it will appear in a web browser. 
 
There are six main parts to the MX Window. 

1. Insert Bar 
2. Panel Group 
3. Panel 
4. Document Toolbar 
5. Document Window 
6. Property Inspector 

 
Insert Bar 
 

 
 
 

 
The Insert Bar contains buttons for inserting common web page elements such as images, tables, 
layers, hyperlinks, and rollover images. 
 
There are 13 categories or options tied to the Insert Bar.   Click on the appropriate tab in the 
Insert Bar to change categories and available options while creating or editing a web page.   The 
Dreamweaver MX Introduction class will focus primarily on the Common tab.   
 
Rest your mouse cursor on any icon in the Insert Bar to see what each one of the icons stand for.  
Also, the appearance of the Insert Bar can be changed in the Preferences.  For example, if you 
want to see the tool name in addition to, or instead of their icons. 
 Edit, Preference, General Category, and select an option for Insert Panel 
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Tip:  Most items in the Insert Bar are also available in the Insert Menu. 
 
 
The Property Inspector 
The Property Inspector displays all the properties of the currently selected object.   
 
The Property Inspector can be viewed two ways:  collapsed or expanded 

 
Expanded.    
Click here to 
collapse. 

Document Toolbar 
 
 

 
The Document Toolbar allows access to several page options such as set the page title, change 
the document view from design view to code view, preview in a browser and several other 
options.   
 
The Document Window 
 
The Title Bar contains the title of the current Web Page.  Note this title will also appear in title 
bar of the Web browser.  
 
At the bottom of the Document Window is the Status Bar, which contains tools to help you get 
information about the web page. 
 
The Tag Selector is located in the lower- left corner of the Status Bar and provides easy access to 
HTML tags on your page.  This becomes more important when Behaviors are applied to specific 
tags.   
 
Window Size Pop-up Menu 
 The 760x420 Browser window dimensions represent the viewable area on your monitor.  The 
dimensions are less than the Screen resolution because the browser interface takes up space.   
 
The Screen resolution helps when designing and viewing a web page.  You can see how your 
document will look at different resolutions.    Use this to verify that your page looks good at all 
resolutions. 
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Panel 
Group 

Panel  

 
Download Statistics 
 
The Download Statistics field is located to the right of the Window Size menu.  This field 
displays the estimated file size and download times for the web page being created based on the 
modem settings in the Status Bar category of the Dreamweaver Preferences.    
 
To set or change the Preferences choose   Edit, Preferences, select the Status Bar category.  
Recommended modem setting is 28.8 Kilobits.  Most people connecting through the CSU 
modem pool will connect via a 28.8 modem. 
 
Panels and Panel Groups  
Panels and Panel Groups are designed to help the User work 
more efficiently in Dreamweaver.  The Panels and Panel 
Groups work together to help customize the work space.   The 
majority of Dreamweaver commands are located on both a 
panel and/or a menu.    
 
A Panel Group can have multiple Panels to choose from.  The 
Panel Groups can be displayed in an Open style or a Collapsed  
Style by clicking with the mouse on the arrow to the left of the 
Panel Group Name.   
 
Switch between the different Panels in the Panel Groups by 
clicking with the mouse on the Panel tab. 
 
The Window menu can also be used to open or close a panel.  
When viewing the Window menu, any item that has a check 
mark to the left of the panel name is open or displaying.   
 
 
 
 
Site Management 
Site Management is a mechanism used to keep track of web pages you build for a specific web 
project and the assets you use in them.  Think of  Site Management as a holding tank or a central 
storage location for all related files, also known as a  Root Folder. 
 
Creating and Defining a Site 
Create a Site prior to building any pages for your web project.  The Site you create will have a 
unique name and a storage folder, Local Root Folder, which will be used to hold all the related 
pages for the web project.   Note, all items used in your web project must be stored in the 
specified Local Root Folder, which you specified within the Site for the project. 
 
From the Menu toolbar select Site, New or Press the shortcut key F5  to open the Site Definition 
dialog box. 
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Specify a Site Name by clicking with 
the mouse in the Site Name field.   
 
The Site Name is an internal naming 
convention.   When naming the Site, 
don’t worry about spaces or 
capitalization.   The Site Name is 
like a “pet name” for your project.  
The Site Name is never transferred 
to the Web or Remote server. 
  
Select the Folder icon to the right of 
the Local Root Folder field to create 
a new Local Root Folder or browse 
and select the folder that will hold 
the web site and be known as the 
Local Root Folder. 
 
All files and assets that you plan on 
using in your web project must be 
stored in the Local Root folder. 
 

When back to the Site Definition dialog box the Local Root Folder should display the folder 
name just created or selected.   
 
All the files and subfolders that you use for your Site should be stored in the specified Local 
Root folder so that when you create your pages, the graphics and links are relative to the that 
folder.  When you get ready to publish, you will only need to copy the root folder, which will 
contain all files and subfolders, and copy (Put) them on the Remote Server (Web Server) from 
your Local computer.   
 
When you Put your Site on the Remote Server, Dreamweaver will maintain an identical 
directory structure as your Local Root to ensure links and references work.   
 
New to MX:  The Site dialog box needs to know where all the images are stored within your 
Site.  Use the Default Images Folder field to point to the folder within your Local Root Folder 
that will contain or hold all images for the files within the web project specified in the Site dialog 
box.  Note, if you don’t have a folder created for your images, then click with the mouse on the 
Folder icon to the right of the field and create a new folder to house the images. 
 
From the Site Definition dialog box be sure to select the Refresh Local File List Automatically 
so that Dreamweaver updates the site list when it has been modified.    
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From the Site Definition dialog box be sure to select the Enable Cache.  This feature will create 
a cache that will help increase the speed for link management while working in Dreamweaver.  
The Site is now defined.   
 
 
 
Browser Preview 
Dreamweaver is a WYSIWYG program, meaning what you see is what you get.  However, it’s 
still a good idea to view your page in different browsers prior to publishing to make sure they 
look good.  Dreamweaver lets you set your preferences and specify the browsers you want to 
preview your creation in.  Dreamweaver preferences can hold up to twenty different browsers, 
but the two most common are Netscape Navigator and Internet Explorer.  Note:  you must have 
these programs installed on your computer before you may use the preview option.  Both 
browsers may be downloaded from the Internet. 
 
 Netscape Navigator  à http://home.netscape.com/computing/download/  
 Microsoft Internet Explorer à http://www.microsoft.com/windows/ie/ 
 
The Preview in Browser option is located in the File menu or in the Document toolbar.  From the 
File menu select Preview in Browser and select a browser from the fly-out menu.  The Preview 
in Brower icon located in the Document toolbar works the same way. 
 
The shortcut key for the browser is located to the right of the browser name in the Preview in 
Brower fly-out menu.   For example, to launch the Preview in Browser using the Internet 
Explorer browser, press F12. 
 
Adding  Browsers  
To add or delete a browser, choose Edit, Preferences,   and 
select the Preview in Browser category.  From the Preview 
in Browser dialog box, select the Plus icon to add a new 
browser or the Minus icon to remove a browser. 
 
Tip:  Internet Explorer is the default primary browser.   
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Creating A Basic Web Page 
Dreamweaver opens with an empty window, ready to create or open a document.  To open a new 
window choose  File,  New.      
 
Saving Your File   
Always save your document as soon as you open a new document by choosing File, Save As.   
Name your files with meaningful file names and use lowercase letters or numbers for your file 
names.  Note, when naming and saving your files don’t use spaces in your file names; instead 
use the underscore or dash.  Dreamweaver automatically adds the extension .htm to your file 
name when you save.   You can change the file extension by choosing  Edit, Preferences and 
change the Add Extension When saving option from the General Category.   
 
Adding a Title  
Always give every HTML document a title.  The document title appears in the title bar of the 
Dreamweaver window and the browser title bar.   It’s important to give your title a meaningful 
name because the title name will be used as a browser bookmark or favorite.   
 
A title can be added by using the Title field in the Toolbar 
 
 
 
or by choosing  Modify, Page Properties.    Page Properties can also be accessed by right-
clicking with the mouse and selecting Page Properties from the menu. 
 
Notice  (untitled-1*) appears to the right of the page title.  This text is displayed because the file 
hasn’t been saved yet.  Once the file has been saved the (untitled-1*) will change to display 
filename. 
 
 
Modifying Page Properties 
Page Properties include the title, background color, background image, text color and hyperlink 
color.  Choose Modify, Page Properties to edit properties. 
 
Selecting Color 
There are 216 web safe colors and 213 of the web safe colors appear the same in Netscape and 
Internet Explorer browsers on both Windows and Macintosh operating systems.    Dreamweaver 
will replace the non-web safe web color with the closest web safe color when the Snap to Web 
Safe option is selected when choosing a color from Windows OS, Mac OS or Grayscale color 
palette.  Creating or using a custom color, which isn’t displayed in the color-safe palette, could 
have an adverse appearance in some browsers.    
 
The cursor icon changes to an Eyedropper and it is used to select colors from the color-palette.  
You can also use the Eyedropper to select any color displayed on your desktop.  The Eyedropper 
will pick up the color and display it in the Current Color box.    As you move the cursor over the 
color swatches the color that your cursor is resting on will display in the upper left hand corner 
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of the color-picker box.   The hexadecimal number for the color will be displayed to the right of 
the color swatch.    

 
Located in the upper right corner of the color palette are two icons.  

The first icon is the Strikethrough button and is used to clear the current color without choosing a 
new color.   The second icon is the Color Wheel button and is used to create custom colors.   
 
Background Color   
The background default color of a web page is white.  To change the background color choose 
the Background option from the Page Properties dialog box or use the shortcut key Ctrl+J to 
access the Page Properties dialog box.    Remember to use light colored text if you choose a dark 
background.  NOTE:  Background images override background color. 
 
Text Colors  
 
Click on the color swatch to the right of Text Color to select a color, which will return you to the 
Page Properties dialog box.   If you know the hexadecimal number for the color, you may type it 
directly in the Page Property dialog box to the right of the Text Color field. 
 
Link Colors  
Use the Page Properties dialog box to change colors for the Links, Visited Links and the Active 
Links.  The link colors chosen from the Page Properties dialog box will apply to the entire 
document. 
 
Types of Links: 
The Links option is the initial color of a hyperlink, the color a user sees before clicking the link.  
The default browser color of Links is Blue. 
 
The Visited Links option is the color the link changes to when a user clicks on the link.  The 
default browser color of the Visited Link is Purple. 
 
The Active Link option is the color the link changes to while the user holds down the mouse 
button after clicking the link.  The default browser color of the Active Link is Red. 
 
Page Margins  
Margin tags were new in Dreamweaver 3 and work with version 4.0 of Netscape and Internet 
Explorer or later.   
 
To access the Page Margins choose Modify, Page Properties or use the shortcut key Ctrl+J.  
Notice there are four different types of margins to create.  Set the left margin and margin width 
to the same number and set the top margin and margin height to the same number if you want 
your pages to appear similar in both browsers, Netscape and Internet Explorer.   
 
Note:  Left Margin and Top Margin are supported by Internet Explorer 4.0 or later. 
Note:  Margin Width and Margin Height are supported by Netscape Navigator 4.0 or later. 
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Tip: Omit the Offset 
Set page margins to zero to omit the offset between the way foreground and background images 
are displayed in html pages on Netscape and Internet Explorer.    Select a different Window Size, 
located in the status bar, to see how your text looks with your margin settings.   
 
Preset Color Scheme 
Dreamweaver provides preset color schemes for the background, text, and links.  A Color 
Scheme can be applied to a page at anytime by choosing   Commands, Set Color Scheme. 
Tip:  Color Schemes cannot be created from the Set Color Scheme dialog box. 
 
Adding Text  
There are several different ways one can insert text on a web page in Dreamweaver.  One could 
type the text directly on the canvas, copy text from a different file and paste it into the canvas, 
import a text file, or even import a web page that was created in Microsoft Office. 
 
Typing Text Directly on the Canvas 
Position the cursor on the canvas and type the text.  Use the Properties Inspector to format the 
text by adding headings, font styles, colors and more. 
 
 
Formatting Text 
 
Formatting options are located in the Property Inspector.  Access the Property Inspector by 
choosing   Window,  Properties or use 
the shortcut key Ctrl+F3.   
 
Format Field 
None:  Removes only paragraph 
formatting such as Headings.  e.g. Heading 1.  This option will not remove formatting that was 
applied manually such as bold, italic,  font color and different font sizes.   
 
Paragraph:The Paragraph option adds paragraph tags, <p></p>, to the selected area.   Anytime 
you press the Enter key in Dreamweaver it is considered a paragraph.  The paragraph could be 
one word or several sentences.  At the end of the paragraph Dreamweaver automatically inserts a 
double space below the typed text and includes the <p></p> tags around the text in the 
paragraph.   
 
Heading: There are six Headings available.  Heading 1 is the largest and Heading 6 is the 
smallest.  A Heading it will be applied to the entire paragraph.  
 
Tip:  When using Headings, a blank line will be inserted above and below the text that contains 
the Heading. 
 
Preformatted: This style is preformatted and displays text in a non-proportional font.  The 
default font style is Courier and the default font size is 10pt. 
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Inserting Spaces 
There will be times when single character spacing is needed between words or letters.  The tab 
key doesn’t really work in HTML files and the Indent option indents the entire paragraph.  Add 
spaces to your text by pressing the shortcut keys Ctrl+Shift+Spacebar or by choosing Insert, 
Special Characters, Non-Breaking space .   Repeat for each space needed.    
 
Text Size Field 
The text size option is located in the Size field on the Property Inspector palette.  The size can be 
selected prior to typing text or can be applied to selected text.  The sizes range from 1 to 7 with 1 
being the smallest and 7 being the largest.  The default size is set at 3. 
 
Font Style Field 
Dreamweaver groups similar Font Styles together.   When you create a website and select a font 
style, it may look great on your machine, but what if the end user doesn’t have that font 
available?  Dreamweaver tries to address this situation by offering groups of fonts commonly 
available in Windows and on the Macintosh.   If the user doesn’t have any of the fonts in the 
Font Style group then the browser will use the default font, usually Times 
Roman. 
 
To create or modify a Font Group, select the Font Style icon in the 
Properties Inspector and choose Edit Font List from the menu.  
 
 
Lists  
There are two types of lists in Dreamweaver:  Unordered List, which are symbols, and Ordered 
List, which are numeric.  Both the Unordered List icon and the Ordered List icon are available in 
the Property Inspector.    Press the shortcut key Ctrl+F3 or choose the Properties option from the 
Windows Menu.   The Unordered List and the Ordered List can be applied to text prior to typing 
text or after.   
 
When creating your list, be sure to press the Enter key at the end of each line.  If you use the 
Shift+Enter to insert a single return, Dreamweaver will not 
recognize the line as a paragraph and the list symbol will 
only be applied to the first item in your list rather than 
every line in your list. 
 
Once a list exists on a page, then the List Item properties 
can be access from the Property Inspector.  
 
Tip:  The color of the symbol will default to the text color on the Page Properties menu. 
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Images 
The two standard images types that most browsers support are GIF and JPEG.   
 

• GIF (CompuServe Graphics Interchange Format  - GIF extension)  
• JPEG (Joint Photographic Experts Group - JPG or JPEG extension)  

 
GIF art images lack the higher quality of JPEG files, but are more compact and display more 
quickly in web browsers.  GIF images work well for black and white "wireframe" or line 
drawings while JPEG images are more appropriate for "raster" or full color images (such as 
photographs). 
 
For Your Information: 
A new image format called PNG (pronounced “ping”) is becoming a replacement for GIF 
images.  PNG supports alpha channels that are useful for transparency.  Microsoft Internet  
Explorer 4.0 and Netscape Navigator 4.0 both display PNGs but have difficulty with alpha 
channels and some of the more advanced characteristics of this format. 
 
 
You can create your own images, scan them, or buy them as part of a commercial clip art 
package. You can also find GIF and JPEG images in the Internet's many image archives. 
 
Inserting an Image 
 
***Save your page first. Place the cursor where you want to insert the image.   From the Insert 
Menu choose Image and browse to select the image.   An image can also be inserted by choosing 
the Image icon from the Common Tab located in the Inset Bar. 
 
Alternative Text  
Alternative text can be displayed in place of an image. You should specify alternative text for 
those readers who use text-only browsers or have image loading turned off.  In addition, use of 
alternative text allows visually impaired users who use speech synthesizers to read text on a web 
page.  When inserting alternative text, be sure to use descriptive text for the images.   For 
example, alternative text which reads “a car” is not as descriptive as “a blue 1965 Ford 
Mustang”.   Use alternative text to give meaning to your image so the information is accessible 
to all users.  Most browsers display the alternative text as a tool tip when the mouse rolls over the 
image. 
 
Adding Alternative Text: 
Select the image and the Property Inspector palette will change to display image properties.   
Position the cursor in the Alt field and type the alternative text. 
 
Image Alignment 
Select the image and choose the Left, Center or Right Align buttons from the Property Inspector 
to move the image.   
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Text and Image Alignment 
The Align field located on the Property Inspector lets you control the way text will appear 
around your image.  The default setting for the Align option is Browser Default, which is the 
same as baseline alignment.   
 
Hyperlinks 
A hyperlink can be used several different ways, for example to  “jump” from one area of a 
document to another area within the same document,  launch an email window,  jump to a web 
site or launch a different file.  Hyperlinks can be linked from text or graphics.  A “text” hyperlink 
is normally identified with an underline.  The link color is normally blue for an unvisited link 
and red for a visited link.  However, these colors can be customized.  A “graphic” which is 
hyperlinked is normally identified when you roll your mouse over the image and the pointer 
changes to a “pointing finger”.  A Hyperlink can be a link to other sites on the WWW,  a link to 
a file, an Email link or an Anchor. 
 
The Hyperlink button is located in the Property Inspector palette.   A hyperlink can be created by 
first selecting the text or object that will be used as the hyperlink, and second, typing the address 
of the web page or file you’re linking to in the Link field, selecting a file through the Browse 
button or by pointing to a file, choosing the browse button and selecting the file, or by using one 
of the methods described below. 
 
Creating a link to email. 
The Insert E-mail link button from the Common tab or the Link field on the Property Inspector 
palette can be used to create an email hyperlink.    
 
1. Creating the email link from the Property Inspector:  From your Dreamweaver page, 

highlight the object or text that will be used as a hyperlink.  In the Link field type the 
following tag:  mailto:username@emailaddress.colostate.edu   
Note:  there are no spaces in the syntax above.       

 
2. Creating the email link from the Common tab.  From your Dreamweaver page highlight the 

text that will be used as a hyperlink.    From the Common tab choose the E-Mail Link icon.  
An Insert E-Mail Link dialog box will open.  The text selected prior to choosing the E-Mail 
Link icon will display in the Text field and will be used as the hyperlink.  Note:  the text that 
will be used as the hyperlink can be changed in the dialog box.  Type the email address in the 
E-Mail field for the hyperlink.  Example:  fran@lamar.colostate.edu.  Note:  You do not need 
the mailto: in front of the email address when using the Insert E-Mail Link icon from the 
Objects Palette. 

 
Editing a Hyperlink 
Select the link and view the link properties in the Property Inspector palette.   An email address 
can be changed in the link field or a different file can be selected for the link by choosing the 
Browse button and selecting a different file.  Note, you can also right-click with the mouse on 
any link and get options to delete, change or edit the link. 
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Creating an Anchor 
 
An Anchor   is a link to a specific area in a document.  Anchors are especially useful in 
long documents.  Creating an Anchor is a two-step process.  First, create the Anchor and second, 
link to the Anchor. 
 
Position the cursor at the beginning of a word where you want to insert an Anchor.  From the 
Insert Menu select Named Anchor or press the shortcut keys Ctrl+Alt+A.  Note, the Common 
tab displays a Named Anchor that can also be used when creating anchors. 
 
A Named Anchor dialog box will display.  Type a 
name for the anchor and do not use any spaces in the 
Anchor Name.  Press OK when finished.  
 
 
 
Note:  If the Anchor Marker doesn't appear at the insertion point location, choose View, Visual 
Aids, Invisible Elements.   Anchor Names are case sensitive. 
 
 
Link to an Anchor using the Point-to-File icon in the Property Inspector.   
Select the text that will be used as the hyperlink.  Next, click on the Point-to-File icon with the 
mouse and hold and drag to the Anchor.  When the arrow from the Point-to-File icon is on the 
Anchor tag and it turns blue, then release the mouse. 
 
Inserting Text From Other Applications 
Use the cut/copy/paste method to insert text from other applications into Dreamweaver.  Note, 
Dreamweaver can paste only plain text, but will retain text in separate paragraphs, as its original, 
when using the cut/copy/paste feature.  Use the Properties Inspector to format the text by adding 
headings, font styles, colors and more. 
 
Dreamweaver 3:  use the Edit, Paste as Text  option instead of just Paste. 
 
 
Inserting Excel Information 
Open the file in Excel and save the file as a text file, tab delimited. 
  
From Dreamweaver choose File,  Import, Import Tabular Data.  From the Import Table Data 
dialog box select the Browse button and select the Excel text file.  Note:  if the text file was not 
saved in Tab Delimited format, then select the correct delimiter from the Delimiter pull-down 
menu. 
. 
Format the Imported Tabular Data 
Format the inserted data by choosing Commands, Format Table.  From the Format Table dialog 
box, select a color scheme for the table.   
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Sort the Imported Tabular Data 
Sort the inserted data by choosing Commands, Sort Table.  From the Sort Table dialog box, 
select sort options. 
 
Importing Office HTML Documents into Dreamweaver 
 
Choose   File,  Import,  Import Word HTML, select the .htm or .html file.  A Clean up Word 
HTML dialog box will display.  Note: You are pretty safe to go with the default options. 
 
Dreamweaver creates a new HTML document, imports the file, and cleans up the code.  If the 
Show Log on Completion option is selected, Dreamweaver informs you of the modifications 
made.   Dreamweaver provides a full set of options so you can tailor the Word-to-Dreamweaver 
transformation.    There are two different sets of options - one for Word 97/98 and one for those 
saved Word 2000.   The different sets of options can be seen on the Detailed tab of the Import 
Word HTML dialog box.   
 
 
 
 


